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ABSTRACT 
 
Version 1.0 of the Department of Defense Explosives Safety Board (DDESB) Blast 
Effects Computer (BEC) was demonstrated at in 1997, Version 2.0 was released in 1998 
and Version 3.0 was published in 1999.  With every version, the capabilities of the BEC 
have been increased.  Version 4.0 continues this trend.  This latest version adds the High 
Performance Magazine to the list of structures and also revises the algorithms used for 
predicting the effects from Aboveground Structures.  In addition, this new version 
includes the effects of altitude on airblast.  The paper will also show several uses of the 
BEC. 
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BACKGROUND 
 
The Department of Defense Explosives Safety Board (DDESB) has had an active role in 
producing various types of explosion effects computation aids1.  In 1978, these 
culminated in the release of a circular slide rule called the “Blast Effects Computer 
(BEC)2.”  This slide rule was designed to solve problems and provide data related to the 
expected damage to various potential targets due to blast effects resulting from an 
explosion of ammunition or explosives stored above ground or in earth-covered 
magazines.   
 
The algorithms that were developed for the original BEC are described in detail in 
Reference 1.  In 1997, these algorithms were implemented into an EXCEL spreadsheet 
template.  This version, Version 1.0, referred to as BECV1, was released in November 
1997 and was reported at PARARI 973.  Version 2.04 was released in 1998 as BECVE2 
and BECVM2.  BECVE2 is in English units and BECVM2 is in Metric units.   In 1999, 
Version 3.0 was released5.  With the release of Version 3.0, several additional Potential 
Explosion Sites (PES) were added.  Algorithms for predicting both dynamic pressure and 
dynamic pressure impulse, more accurate algorithms for estimating the probability of 
window breakage, and algorithms for predicting the probability of ear drum rupture and 
the probability of lethality due to lung damage were also included. 
 
The current version, Version 4.0, includes the following changes: 

• Improvement of  the low pressure yield estimates (resulting in improved airblast 
predictions at pressures below 1 psi) 

• Revision of the algorithms used for above ground sites (AGS) 
• Presents the effects of PES altitude on airblast 
• Automatic English-Metric and Metric-English conversions 
• Warning flags when input conditions are out of range 
• Automatic generation of a summary table 
• Revision of the input-output interface 

 
VERSION 4.0 GENERAL INFORMATION 

 
Version 4 of the Blast Effects Computer is also written as a Microsoft EXCEL 
spreadsheet template.  In order to use Version 4, EXCEL 97/EXCEL 98 (or later) must 
already be installed on your computer.  Simply copy the template to your hard drive.  To 
use the program, either double click on the BECV4 filename or launch EXCEL and then 
use the OPEN command located in the FILE menu.  Because it is written as an EXCEL 
template, the Blast Effects Computer will run on any machine that can run EXCEL.  At 
this time, it has been tested on both Macintosh and WINTEL machines.  
 
When you run the template, EXCEL opens a copy of the spreadsheet for you to use.  
Changes you make affect only the copy--the original template is preserved.  The copy of 
the template is a new, unsaved document with a temporary name based on the template 
name.  For example, when you open the Blast Effects Computer template named 
BECV4.xlt, Microsoft EXCEL gives the copy the temporary name BECV41.  When you 



save or close the copy, the Save As dialog box appears.  You can type a new name for the 
document, accept the temporary name suggested by EXCEL, or you don’t save this copy 
when you close out.  
 
When you open the template with EXCEL 97/EXCEL 98, you will be presented with a 
dialog box that indicates, “ ... contains macros”.   Click on the “Enable Macros” button 
to proceed.   
 
The following templates are available: 

• English Units 
• Conversion of the English Units Worksheet into Metric Units 
• Metric (SI) Units 
• Conversion of the Metric Units Worksheet into English Units 

 
At the start of a session, the user simply selects the appropriate tab at the bottom of the 
worksheet.  The two “Conversion tabs” work as follows.  The “English-to-Metric 
Conversion” simply converts what is shown on the “English Units” worksheet into the 
corresponding Metric units.  The “Metric-to-English Conversion” converts what is 
shown on the “Metric Units” worksheet into English units. 
 

CHANGES INCORPORATED INTO VERSION 4.0 
 
The results6 of the recently conducted 40-tonne trial in Australia were used to 
update/refine the AGS algorithms used in the BEC.  Previous data7 seemed to indicate 
that the presence of a barricade (traverse) might have an effect on the airblast measured 
behind the barricade.  This was reflected in Version 3 with predictions for both 
barricaded and unbarricaded directions around an aboveground site (AGS).  The 40-tonne 
data showed that this was not the case.  The measured results in both the barricaded and 
unbarricaded directions fell on the same pressure-distance curve. In addition, the 40-
tonne data showed that there was a problem with the low-pressure hemispherical yields 
used by the BEC; namely, the yields were too low, resulting in predicted pressures and 
impulses that were lower than the measured values.  These differences are discussed in 
more detail in Reference 6.  Version 4 corrects both of these problems. 
 
The Blast Effects Computer predicts the airblast for sea level conditions.  If the PES is 
not at sea level, corrections should be made for the atmospheric conditions (barometric 
pressure and temperature).  These corrections are discussed in Reference 8.  The 
following equations summarize these corrections: 
   ∆Pz   =  ∆P0 * Sp 
   Rz    =  R0* Sd 
   Timez   =  Time0* St 
   Impulsez  =  Impulse0 * SI 
 
Where the subscript z refers to the parameter at altitude, z, and the subscript 0 refers to 
the parameter at sea level.  P represents pressure and R distance.  The formulae for the 
correction factors Sp, Sd, St, and SI are shown below.  



  Sp = (Pz/P0) 
 
  Sd = (P0/Pz)1/3 
 
  St = (P0/Pz)1/3 * (T0/Tz)1/2 
 
  SI = (Pz/P0)2/3 * (T0/Tz)1/2 
 
where P0 = atmospheric pressure at sea level (14.696 psi or 101.3289 kPa) 
  Pz = atmospheric pressure at altitude z 
  T0 = atmospheric temperature at sea level (288.16°K) 
  Tz = atmospheric temperature at altitude z 
 
These corrections are implemented in Version 4 by entering either an altitude or 
atmospheric pressure and the temperature.  The BEC displays the computed correction 
factors and two sets of output predictions—one for sea level and one for the conditions 
specified. 
 
Another new feature in Version 4.0 is the automatic generation of a summary table.  This 
table shows the variation of the various sea level airblast parameters with distance.  The 
user selects an initial range (R) and the table is automatically generated.  The default 
distances used in the summary table are:  R, 1.2*R, 1.4*R, 1.6*R, 1.8*R, 2.0*R, 2.5*R, 
3*R, 4*R, 5*R, 6*R, 7*R, 8*R, 9*R, 10*R, 14*R, 16*R, 18*R, 20*R, 25*R, 30*R, and 
50*R.  In addition, the first line of the table will always be the values for the “Range to 
ES” that was selected. 
 
The following warnings are generated when the associated inputs are out of range: 
  ECM (total NEW must be less than 500,000 pounds or 226,795 kg) 
  HAS (total NEW must be less than 10,000 pounds or 4536 kg) 
  AGS (total NEW must be less than 500,000 pounds or 226,795 kg) 
  Ship (total NEW must be less than 2,000,000 pounds or 907,180 kg) 
  HPM (MCE must be less than 60,000 pounds or 27,215 kg) 
 
In addition, warnings are generated if the apparent scaled range (actual range/equivalent 
hemispherical weight 1/3) is too large or too small.  Too small is defined as less than 2 
ft/lb1/3  (0.79 m/kg1/3) and too large as greater than 100 ft/lb1/3 (39.67 m/kg1/3). 
 

USING THE COMPUTER 
 
The following steps should be followed to use the computer: 

• Launch the template -- either by double clicking on the template icon or by 
starting EXCEL and using the open command (under the File menu)  

• Select either English Units or Metric Units from the tabs at the bottom 
• Enter the required information in the INPUT SECTION 



• Use the Potential Explosion Site  menu to choose the appropriate PES 
• Use the Select Type of Weapon menu to choose the appropriate type of 

weapon 
• Use the Select Type of Explosive menu to change the default explosive 

type (if necessary) 
• Choose either a Total NEW or Number of Weapons from the Select 

Number of Weapons or Total NEW menu. 
• Enter either the Total NEW or the Number of Weapons as required  
• Enter Range to ES 
• Enter Initial Range for Summary Table 
• Use the Select Atmospheric Description menu to choose either altitude or 

barometric pressure (Note:  if altitude corrections are not required, this 
step may be omitted) 

• Enter either the Altitude or the Barometric Pressure as required (Note:  
if altitude corrections are not required, this step may be omitted) 

• Enter Temperature (Note:  if altitude corrections are not required, this 
step may be omitted) 

 
When those inputs are completed, the results are immediately available in the output 
section.  In addition to the specific run for the input conditions listed above, a summary 
table is also generated.  This table is located below and to the right the general BEC 
output.  When Print is selected from the File menu, two pages will be generated.  The 
first page contains INPUT and OUTPUT sections for the specific run; the second page is 
the summary table.  The heading at the top of the summary table repeats the input 
selections that have been made and then presents the table itself. 
 
Once you have selected a PES, weapon type, and explosive type, the explosion effects are 
dependent upon the inter-relationship of three sets of data:  the Net Explosive Weight (or 
Number of Weapons), the selected range, and the type of explosion effect (time of 
arrival, peak pressure, probability of fatality due to lung rupture, etc.).  If two of these are 
known, then the third can be computed.  When the NEW and range are known, the BEC 
computes the effect.  This is the procedure described above.  However, it is sometimes 
useful to reverse the process; i.e., to enter the effect and either the range or NEW/Number 
of Weapons and compute the other variable.  This reverse process is referred to as “Back 
Calculation.”  
 
When it is planned to use this feature, either the range or the NEW must be entered at the 
top of the spreadsheet.  An arbitrary value for the other input variable must also be used--
any number greater than zero.  Make the appropriate selections from the other inputs:  
Select  Explosion Site, Select Type of Weapon, and Select Type of Explosive.  When the 
other inputs are complete, select the Goal Seek Function under the EXCEL TOOLS 
menu.  When this option is selected, the following dialog box (Figure 1) is displayed: 



Set Cell:

To Value:

By Changing Cell:

CANCEL OK

GOAL SEEK

 FIGURE 1.  GOAL SEEK DIALOG BOX

Enter the Cell Reference of the cell you wish to compute into the Set Cell: box.  Enter the
value you wish the cell to obtain in the To Value: box.  Enter the Cell Reference of the
Cell you wish to change into the By Changing Cell:  box.  The Cell Reference can be set
by first placing the cursor in the appropriate GOAL SEEK dialog box then clicking on
the cell of choice in the BEC.

SAMPLE PROBLEMS

The following examples are intended to illustrate some of the features of the Blast Effects
Computer.

Example 1.

Twenty-seven tonnes of MK 82 bombs (Tritonal filled) will be detonated inside a
barricaded, aboveground structure at or near sea level.  What are the expected airblast
effects at a range of 500 meters from the event?  Generate a pressure-distance curve
for the event.  At what range is there a 40% probability of breaking float annealed
windows whose dimensions are 30.5 cm x 61 cm x 0.02 cm?  What is the English
equivalent output for the 40% window breakage problem?

Choose the Metric Units version of the BEC

Figures 2 and 3 show the output for this example.



FIGURE 2.  EXAMPLE 1: INPUT AND OUTPUT

           Select Potential Select Number of Enter initial range for Select Atmospheric
        Explosion Site (PES) Weapons or Total NEQ Summary Table Description

100
              Select Type Enter Total Enter
              of Weapon NEQ (kg) Altitude (m)

27,000.0 1,000.00
              Select Type Enter
             of Explosive Range (m) Temperature (°C)

500.0 15.00
                                                                                   

EXPLOSIVE   PARAMETERS
Total NEQ (kg) 27,000.0 Pressure (mbar) 897.4
NEW per weapon (kg) 87.090 Temperature (°C) 15.00
TNT Equivalence 1.07 Pressure (Sp) 0.8857

Distance (Sd) 1.0413
Equivalent  Hemispherical Weight (kg) 19,332.2 Time (St) 1.0413
Effective Yield (kg) 28,890.0 Impulse (SI) 0.9223
(N.B.:  Both Weight and Yield are in kg of TNT)

SEA LEVEL ALTITUDE (meters)     
1000

Range (m) 500.0 442.9

Time of Arrival at Range (msec) 1230.88 1281.7

Over-Pressure at Range (kPa) 6.67 5.9

Reflected Press. at Range (kPa) 13.63 12.1

Positive Phase Duration 156.4 162.9
 at Range (ms)

Positive Phase Impulse 456.9 421.4
 at Range (Pa-s)

Reflected Impulse 829.1 764.6
 at Range (Pa-s)

Dynamic Overpressure 0.2 0.14
 at Range (kPa)

Dynamic Overpressure Impulse 9.3 8.6
 at Range (Pa-s)

OTHER    INFORMATION
Probability of Window Breakage Area = 0.186 m2 Area = 1.626  m2

 (percent) at Range 30.5 x 61.0 x 0.223 67.5 152.4 x 106.7 x 0.559 100.0
(note:  dimensions are cm) Float annealed Plate annealed

Area = 0.372 m2 Area = 2.787  m2

61.0 x 61.0 x 0.223 100.0 182.9 x 152.4 x 0.559 100.0
Float annealed Plate annealed

Area = 0.975 m2 Area = 4.645  m2

106.7 x 91.4 x 0.305 100.0 304.8 x 152.4 x 0.762 100.0
Float annealed Plate annealed

Probability of Eardrum Rupture 0.0 (Mercx)

(percent) at Range 0.0 (Eisenberg)

Probability of lethality due to lung 0.0
damage (percent) at Range

INPUT SECTION
Metric Units (kg, m, kPa, Pa-s, ms)

ATMOSPHERE   PARAMETERS

OUTPUT SECTION

AIRBLAST    PARAMETERS

MK82 (500 lb Bomb)

AGS Total NEQ (kg)

Tritonal

Altitude (meters)



 
 

FIGURE 3.  EXAMPLE 1:  SUMMARY TABLE 
 
 
The second portion of the example was to determine the range at which there was a 40% 
probability of window breakage for a particular sized window.  This can be accomplished 
using the same input conditions and then choosing the GOAL SEEK option under the 
Tools menu.  When the GOAL SEEK dialog appears, set up the problem as follows: 
  Set Cell:    $C$53 (Window Breakage probability) 
  To Value:    40 
  By Changing Cell: $B$11 (range) 
 
The answer is 635 meters.  This can be seen in Figure 4, which gives the Metric output 
for this problem.  The information contained in this figure can be converted to English 
units using the Metric-to-English conversion.  This is shown in Figure 5. 
 
 
 
 

  Explosion Site (ES) AGS   Type of Weapon MK82 (500 lb Bomb)
  Type of Explosive Tritonal Total NEQ (kg) 27,000.00

RANGE TIME OF INCIDENT INCIDENT POSITIVE REFLECTED REFLECTED DYNAMIC
ARRIVAL PRESSURE IMPULSE DURATION PRESSURE IMPULSE PRESSURE

(meters) (ms) (kPa) (Pa-s) (ms) (kPa) (Pa-s) (kPa)
500.0 1230.88 6.67 456.90 156.41 13.63 829.08 0.16
100.0 148.20 60.35 1683.80 84.05 149.17 3713.82 12.53
120.0 192.79 46.91 1555.01 93.48 111.02 3324.60 7.59
140.0 240.10 37.82 1430.47 101.09 86.73 2983.93 4.90
160.0 289.49 31.36 1315.26 107.43 70.29 2689.43 3.34
180.0 340.47 26.59 1210.86 112.84 58.59 2435.52 2.38
200.0 392.67 22.96 1117.21 117.58 49.94 2216.26 1.76
250.0 526.82 16.87 924.61 127.38 35.92 1786.08 0.94
300.0 664.32 13.17 779.14 135.27 27.67 1476.52 0.57
400.0 945.05 8.97 580.98 147.44 18.52 1072.63 0.27
500.0 1230.88 6.67 456.90 156.41 13.63 829.08 0.16
600.0 1520.20 5.23 374.39 163.37 10.60 670.97 0.10
700.0 1811.30 4.23 316.82 169.20 8.56 562.54 0.07
800.0 2102.26 3.48 275.12 174.54 7.10 485.02 0.04
900.0 2391.12 2.95 243.49 179.86 6.00 427.80 0.03

1,000.0 2676.20 2.55 218.69 185.46 5.15 384.51 0.02
1,400.0 out of range 1.66 163.90 out of range out of range out of range out of range
1,600.0 out of range 1.44 150.76 out of range out of range out of range out of range
1,800.0 out of range 1.24 137.53 out of range out of range out of range out of range
2,000.0 out of range 1.07 122.97 out of range out of range out of range out of range
2,500.0 out of range 0.78 97.03 out of range out of range out of range out of range
3,000.0 out of range 0.61 79.95 out of range out of range out of range out of range
5,000.0 out of range 0.30 out of range out of range out of range out of range out of range

SUMMARY TABLE
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FIGURE 4.  EXAMPLE 1:  RANGE FOR 40% WINDOW BREAKAGE
PROBABILITY

           Select Potential Select Number of Enter initial range for Select Atmospheric
        Explosion Site (PES) Weapons or Total NEQ Summary Table Description

100
              Select Type Enter Total Enter
              of Weapon NEQ (kg) Altitude (m)

27,000.0 1,000.00
              Select Type Enter
             of Explosive Range (m) Temperature (°C)

634.8 15.00
                                                                                   

EXPLOSIVE   PARAMETERS
Total NEQ (kg) 27,000.0 Pressure (mbar) 897.4
NEW per weapon (kg) 87.090 Temperature (°C) 15.00
TNT Equivalence 1.07 Pressure (Sp) 0.8857

Distance (Sd) 1.0413
Equivalent  Hemispherical Weight (kg) 18,570.9 Time (St) 1.0413
Effective Yield (kg) 28,890.0 Impulse (SI) 0.9223
(N.B.:  Both Weight and Yield are in kg of TNT)

SEA LEVEL ALTITUDE (meters)     
1000

Range (m) 634.8 562.3

Time of Arrival at Range (msec) 1621.40 1688.3

Over-Pressure at Range (kPa) 4.88 4.3

Reflected Press. at Range (kPa) 9.81 8.7

Positive Phase Duration 165.5 172.3
 at Range (ms)

Positive Phase Impulse 352.1 324.7
 at Range (Pa-s)

Reflected Impulse 628.8 579.9
 at Range (Pa-s)

Dynamic Overpressure 0.1 0.08
 at Range (kPa)

Dynamic Overpressure Impulse 5.4 5.0
 at Range (Pa-s)

OTHER    INFORMATION
Probability of Window Breakage Area = 0.186 m2 Area = 1.626  m2

 (percent) at Range 30.5 x 61.0 x 0.223 40.0 152.4 x 106.7 x 0.559 100.0
(note:  dimensions are cm) Float annealed Plate annealed

Area = 0.372 m2 Area = 2.787  m2

61.0 x 61.0 x 0.223 100.0 182.9 x 152.4 x 0.559 100.0
Float annealed Plate annealed

Area = 0.975 m2 Area = 4.645  m2

106.7 x 91.4 x 0.305 100.0 304.8 x 152.4 x 0.762 100.0
Float annealed Plate annealed

Probability of Eardrum Rupture 0.0 (Mercx)

(percent) at Range 0.0 (Eisenberg)

Probability of lethality due to lung 0.0
damage (percent) at Range

INPUT SECTION
Metric Units (kg, m, kPa, Pa-s, ms)

ATMOSPHERE   PARAMETERS

OUTPUT SECTION

AIRBLAST    PARAMETERS

MK82 (500 lb Bomb)

AGS Total NEQ (kg)

Tritonal

Altitude (meters)



FIGURE 5.  EXAMPLE 1:  METRIC-TO ENGLISH CONVERSION

  Explosion Site (PES) AGS
  Type of Weapon MK82 (500 lb Bomb)

  Type of Explosive Tritonal

Total NEQ (kg) 27,000.00
Range to ES (meters) 634.80

EXPLOSIVE   PARAMETERS
Total NEW (lb) 59,525.1 Pressure (psi) 13.02
NEW per weapon (lb) 192.0 Temperature (°C) 15.00
TNT Equivalence 1.07 Pressure (Sp) 0.8857

Distance (Sd) 1.0413
Equivalent  Hemispherical Weight (lb) 40,942.0 Time (St) 1.0413
Effective Yield (lb) 63,691.9 Impulse (SI) 0.9223
(N.B.:  Both Weight and Yield are in lb of TNT)

SEA LEVEL ALTITUDE (feet)     
3281

Range (ft) 2082.68 1844.68

Time of Arrival at Range (ms) 1621.40 1688.33

Over-Pressure at Range (psi) 0.71 0.63

Reflected Press. at Range (psi) 1.42 1.26

Positive Phase Duration 165.49 172.32
 at Range (ms)

Positive Phase Impulse 51.07 47.10
 at Range (psi-ms)

Reflected Impulse 91.20 84.11
 at Range (psi-ms)

Dynamic Overpressure 0.01 0.01
 at Range (psi)

Dynamic Overpressure Impulse 0.78 0.72
 at Range (psi-ms)

OTHER    INFORMATION
Probability of Window Breakage Area = 2 ft2 Area = 17.5  ft2

 (percent) at Range 12" x 24" x 0.088" 40.0 60" x 42 " x 0.22" 0
Float annealed Plate annealed

Area = 4 ft2 Area = 30  ft2

24" x 24" x 0.088" 100.0 72" x 60" x 0.22" 0
Float annealed Plate annealed

Area = 10.5 ft2 Area = 50  ft2

42" x 36" x 0.12" 100.0 120" x 60" x 0.30" 0
Float annealed Plate annealed

Probability of Eardrum Rupture 0.0 (Mercx)

(percent) at Range 0.0 (Eisenberg)

Probability of lethality due to lung 0.0
damage (percent) at Range

ATMOSPHERE   PARAMETERS

AIRBLAST    PARAMETERS

METRIC-TO-ENGLISH CONVERSION
(converts Metric Units Worksheet into English Units)

Units of lb, ft, psi, psi-ms, ms

OUTPUT SECTION



Example 2. 
 

Consider the scenario described in Example 1.  At Sea Level, the pressure is 22.96 
kPa at a range of 200 meters.  If the altitude is 1,600 meters, at what range does this 
pressure (22.96 kPa) occur?   

 
This scenario can be analyzed by using the same input conditions and then entering the 
altitude of 1,600 meters.  Then choose the GOAL SEEK option under the Tools menu.  
When the GOAL SEEK dialog appears, set up the problem as follows: 
  Set Cell:    $D$31 (Incident Pressure at altitude) 
  To Value:    22.96 
  By Changing Cell: $B$11 (range) 
 
The answer is 143 meters.  This can be seen in Figure 6. 

 
FIGURE 6.  EXAMPLE 2:  ALTITUDE EFFECTS 

           Select Potential Select Number of Enter initial range for Select Atmospheric
        Explosion Site (PES) Weapons or Total NEQ Summary Table Description

100
              Select Type Enter Total Enter
              of Weapon NEQ (kg) Altitude (m)

27,000.0 1,600.00
              Select Type Enter
             of Explosive Range (m) Temperature (°C)

173.9 15.00
                                                                                   

EXPLOSIVE   PARAMETERS
Total NEQ (kg) 27,000.0 Pressure (mbar) 833.4
NEW per weapon (kg) 87.090 Temperature (°C) 15.00
TNT Equivalence 1.07 Pressure (Sp) 0.8226

Distance (Sd) 1.0673
Equivalent  Hemispherical Weight (kg) 19,029.8 Time (St) 1.0673
Effective Yield (kg) 28,890.0 Impulse (SI) 0.8779
(N.B.:  Both Weight and Yield are in kg of TNT)

SEA LEVEL ALTITUDE (meters)     
1600

Range (m) 173.9 143.0

Time of Arrival at Range (msec) 324.67 346.5

Over-Pressure at Range (kPa) 27.91 23.0

Reflected Press. at Range (kPa) 61.80 50.8

Positive Phase Duration 111.3 118.7
 at Range (ms)

Positive Phase Impulse 1241.8 1090.1
 at Range (Pa-s)

Reflected Impulse 2509.6 2203.1
 at Range (Pa-s)

Dynamic Overpressure 2.6 2.16
 at Range (kPa)

Dynamic Overpressure Impulse 91.9 80.6
 at Range (Pa-s)

INPUT SECTION
Metric Units (kg, m, kPa, Pa-s, ms)

ATMOSPHERE   PARAMETERS

OUTPUT SECTION

AIRBLAST    PARAMETERS

MK82 (500 lb Bomb)

AGS Total NEQ (kg)

Tritonal

Altitude (meters)



WHY NOT CONWEP? 
 
Why is the BEC necessary?  Why not use an already existing program such as 
CONWEP9 to perform the required analyses?  Why is another set of software necessary?  
The BEC is optimized for airblast predictions.  It takes into account the effect of the PES, 
the type of weapon, and the TNT equivalence of the explosive.  The BEC results are 
within a few percent of actual measured data for each of the input options.  CONWEP 
assumes all weapons are spheres or hemispheres and only makes a correction for TNT 
equivalence.  It does not take into account the effects of the weapon case or shape and it 
does not take into account the effects of any structure that may exist around the explosion 
source.  For example, if CONWEP airblast predictions for a MK 82 bomb are compared 
with actual bomb data, the differences can be significant. 
 
SUMMARY 
 
The latest version of the DDESB Blast Effects Computer has been presented.  The 
differences between Version 4.0 (the current version) and previous versions have been 
discussed.  Sample problems that demonstrates some of the features of the calculator are 
presented.  
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